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Reference to the whole or to part of this volume should be made as follows:

Print citation for Chapter 1:
Shipboard Scientific Party, 2001. Leg 191 summary. In Kanazawa, T., Sager, W.W., Escutia, C., et al., 
Proc. ODP, Init. Repts., 191: College Station TX (Ocean Drilling Program), 1–49.

CD-ROM volume citation:
Kanazawa, T., Sager, W.W., Escutia, C., et al., 2001. Proc. ODP, Init. Repts., 191 [CD-ROM]. Available 
from: Ocean Drilling Program, Texas A&M University, College Station TX 77845-9547, USA.

CD-ROM chapter citation:
Shipboard Scientific Party, 2001. Site 1179. In Kanazawa, T., Sager, W.W., Escutia, C., et al., Proc. ODP, 
Init. Repts., 191, 1–159 [CD-ROM]. Available from: Ocean Drilling Program, Texas A&M University, 
College Station TX 77845-9547, USA.

This volume also appears on the World Wide Web. See www-odp.tamu.edu/publications for Web 
citation formats.

http://www-odp.tamu.edu/publications
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Effective publication dates of ODP Proceedings

According to the International Code of Zoological Nomenclature, the date of publication of a work 
and of a contained name or statement affecting nomenclature is the date on which the publication 
was mailed to subscribers, placed on sale, or when the whole edition is distributed free of charge, 
mailed to institutions and individuals to whom free copies are distributed. The mailing date, not the 
printing date, is the correct one.

The printing date of this volume: September 2001
The mailing dates of recent Proceedings of the Ocean Drilling Program:
Volume 187 (Initial Reports): January 2001
Volume 188 (Initial Reports): March 2001
Volume 189 (Initial Reports): May 2001
Volume 170 (Scientific Results): February 2001
Volume 171A (Scientific Results): December 2000
Volume 171B (Scientific Results): April 2001

Copies of this publication may be obtained from Publications Distribution Center, Ocean Drilling 
Program, Texas A&M University, 1000 Discovery Drive, College Station TX 77845-9547, USA. See the 
ODP publication list at www-odp.tamu.edu/publications or contact ODP for prices and ordering 
information. Orders for copies require advance payment.

ISSN
Printed booklet: 0884-5883; CD-ROM volume: 1096-2522; World Wide Web volume: 1096-2158 
Library of Congress 87-642-462

http://www-odp.tamu.edu/publications
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PUBLISHER’S NOTES
This volume also appears on the World Wide Web. Any corrections, revisions, or additions will be 
noted in the chapter (see “Chapter Notes”) at www-odp.tamu.edu/publications.

This publication was prepared by the Ocean Drilling Program, Texas A&M University, as an account of 
work performed under the international Ocean Drilling Program, which is managed by Joint 

Oceanographic Institutions, Inc., under contract with the National Science Foundation. Funding for 
the program was provided by the following agencies at the time of this cruise:

Australia/Canada/Chinese Taipei/Korea Consortium for Ocean Drilling: Department of Primary Industries and 
Energy (Australia), Natural Resources Canada, National Taiwan University in Taipei, and Korean Institute for 
Geology, Mining and Minerals

Deutsche Forschungsgemeinschaft (Federal Republic of Germany)

European Science Foundation Consortium for Ocean Drilling (Belgium, Denmark, Finland, Iceland, Ireland, Italy, 
The Netherlands, Norway, Portugal, Spain, Sweden, and Switzerland)

Institut National des Sciences de l’Univers–Centre National de la Recherche Scientifique (INSU-CNRS) (France)

Marine High-Technology Bureau of the State Science and Technology Commission of the People’s Republic of 
China

National Science Foundation (United States)

Natural Environment Research Council (United Kingdom)

University of Tokyo, Ocean Research Institute (Japan)

http://www-odp.tamu.edu/publications
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Any opinions, findings, and conclusions or recommendations expressed in this publication are those of 

the author(s) and do not necessarily reflect the views of the National Science Foundation, the 
participating agencies, Joint Oceanographic Institutions, Inc., Texas A&M University, or Texas A&M 
Research Foundation.

Abbreviations for names of organizations and publications in ODP reference lists follow the style given 
in Chemical Abstracts Service Source Index (published by American Chemical Society).

The bulk of the shipboard-collected data from this leg is available on the World Wide Web and is 
accessible at www-odp.tamu.edu/database. If you cannot access this site or need additional data, 
please contact the ODP Data Librarian, Ocean Drilling Program, Texas A&M University, College Station 
TX 77845-9547, USA. E-mail: database@odpemail.tamu.edu.

The map at the front of this volume was produced using Generic Mapping Tools (GMT) of Paul Wessel 
and Walter H.F. Smith (gmt.soest.hawaii.edu). A site map showing the drilling locations for this leg 
and maps showing the drilling locations of all Ocean Drilling Program (ODP) and Deep Sea Drilling 
Project (DSDP) drilling sites are available on the volume CD-ROM in PDF format.

Cover photograph, by ODP Photographer L. Shannon Center, is of the drill rig in action at night. 
Except for transit time, the rig runs around the clock.

http://gmt.soest.hawaii.edu
http://www-odp.tamu.edu/database
mailto:database@odpemail.tamu.edu
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FOREWORD

BY JOINT OCEANOGRAPHIC INSTITUTIONS, INC.

This volume presents scientific and engineering results from the Ocean Drilling Program (ODP). These results 
address the scientific and technical goals of the program, which are focused on the study of the dynamics of 
Earth’s interior and environment, the evolution of oceanic crust, and the fluctuations of climate. In addition, 
study of the Earth’s deep biosphere is an emergent research objective.

ODP, an international partnership of scientists and research institutions from 22 countries, operates the drillship 
JOIDES Resolution. This state-of-the-art research vessel contains eight levels of laboratories and other scientific 

facilities required for carrying out the program’s objectives.

The management of ODP involves a partnership of scientists and governments. International oversight and 
coordination are provided by the ODP Council, which is made up of representatives from the member 
countries. Overall scientific and management guidance is provided by representatives from the Joint 
Oceanographic Institutions for Deep Earth Sampling (JOIDES).

Joint Oceanographic Institutions, Inc. (JOI), a nonprofit consortium of 14 U.S. oceanographic institutions, serves 
as the National Science Foundation’s prime contractor for ODP. JOI implements scientific objectives, plans, and 
recommendations of the JOIDES committees through major subcontracts to Texas A&M University (TAMU) for 
science operations and to Lamont-Doherty Earth Observatory (LDEO) of Columbia University for geochemical 
and geophysical well-logging services.

JOI, TAMU, and LDEO have worked together successfully for many years to manage the Ocean Drilling 
Program. We look forward to many exciting discoveries and continued international collaboration as we further 
our scientific mission, especially the planning for the future of ocean drilling beyond 2003.

Steven R. Bohlen
President of the Joint Oceanographic Institutions and Executive Director of the Ocean Drilling Programs
Washington, D.C.
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OCEAN DRILLING PROGRAM*

National Science Foundation
4201 Wilson Boulevard
Arlington VA 22230, USA
Tel: (703) 306-1581; Fax: (703) 306-0390
Web site: www.nsf.gov

MEMBER ORGANIZATIONS OF THE JOINT OCEANOGRAPHIC INSTITUTIONS FOR DEEP EARTH 
SAMPLING (JOIDES)

University of California at San Diego, Scripps 
Institution of Oceanography

Rutgers, The State University of New Jersey, 
Institute of Marine and Coastal Sciences and 
Faculty of Arts and Sciences
University of California, Santa Cruz

Columbia University, Lamont-Doherty Earth 
Observatory

University of Florida

University of Hawaii, School of Ocean and Earth 
Science and Technology

University of Miami, Rosenstiel School of Marine 
and Atmospheric Science

University of Michigan, College of Literature, 
Science, and the Arts

Oregon State University, College of Oceanic and 
Atmospheric Sciences

University of Rhode Island, Graduate School of 
Oceanography

Texas A&M University, College of Geosciences

University of Texas at Austin, Institute for 
Geophysics

University of Washington, College of Ocean and 
Fishery Sciences

Woods Hole Oceanographic Institution

*At time of publication. See Publisher’s Notes, p. 5, for list of funding agencies at time of cruise. For an up-to-date list of
current member organizations and office contact information, see the ODP Web site: www.oceandrilling.org.

http://www.nsf.gov/
http://www.oceandrilling.org/
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Australia/Canada/Chinese Taipei/Korea 
Consortium for Ocean Drilling: Department of 
Primary Industries and Energy (Australia), 
Natural Resources Canada, National Taiwan 
University in Taipei, and Korean Institute for 
Geology, Mining and Minerals

European Science Foundation Consortium for 
Ocean Drilling (Belgium, Denmark, Finland, 
Iceland, Ireland, Italy, The Netherlands, Norway, 

OCEAN DRILLING PROGRAM (ODP)

Web site: www.oceandrilling.org

ODP SCIENCE ADVISORY STRUCTURE 
(JOIDES)

JOIDES Office
University of Miami—RSMAS
Portugal, Spain, Sweden, and Switzerland)

Federal Republic of Germany, Bundesanstalt für 
Geowissenschaften und Rohstoffe

France, Institut National des Sciences de 
l’Univers–Centre National de la Recherche 
Scientifique (INSU-CNRS)

Japan, University of Tokyo, Ocean Research 
Institute

People’s Republic of China, Marine High-
Technology Bureau of the State Science and 
Technology Commission of the People’s 
Republic of China

United Kingdom, Natural Environment Research 
Council 

4600 Rickenbacker Causeway
Miami FL 33149, USA
Tel: (305) 361-4668; Fax: (305) 361-4632
E-mail: joides@rsmas.miami.edu
Web site: joides.rsmas.miami.edu

mailto:joides@rsmas.miami.edu
http://joides.rsmas.miami.edu
http://www.oceandrilling.org/
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ODP PROGRAM MANAGER

Joint Oceanographic Institutions, Inc.
1755 Massachusetts Avenue, NW, Suite 700

ODP LOGGING SERVICES OPERATOR

Borehole Research Group
Lamont-Doherty Earth Observatory
Washington DC 20036-2102, USA
Tel: (202) 232-3900; Fax: (202) 462-8754
E-mail: joi@brook.edu
Web site: www.joi-odp.org

ODP SCIENCE OPERATOR

Ocean Drilling Program
Texas A&M University
1000 Discovery Drive
College Station TX 77845-9547, USA
Tel: (979) 845-2673; Fax: (979) 845-4857
E-mail: odp@odpemail.tamu.edu
Web site: www-odp.tamu.edu

Columbia University
Route 9W
Palisades NY 10964, USA
Tel: (845) 365-8341; Fax: (845) 365-3182
E-mail: borehole@ldeo.columbia.edu
Web site: www.ldeo.columbia.edu/BRG/ODP

ODP SITE SURVEY DATA BANK

Lamont-Doherty Earth Observatory
Columbia University
Route 9W
Palisades NY 10964, USA
Tel: (845) 365-8542; Fax: (845) 365-8159
E-mail: odp@ldeo.columbia.edu
Web site: www.ldeo.columbia.edu/databank

mailto:joi@brook.edu
http://www.joi-odp.org
mailto:odp@odpemail.tamu.edu
http://www-odp.tamu.edu/
mailto:borehole@ldeo.columbia.edu
http://www.ldeo.columbia.edu/BRG/ODP
mailto:odp@ldeo.columbia.edu
http://www.ldeo.columbia.edu/databank
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LEG 191 PARTICIPANTS*

SHIPBOARD SCIENTIFIC PARTY

Toshihiko Kanazawa
Co-Chief Scientist
Earthquake Research Institute
University of Tokyo
1-1-1 Yayoi, Bunkyo-ku
Tokyo 113-0032
Japan
kanazawa@eri.u-tokyo.ac.jp

Eiichiro Araki
Seismologist
Deep Sea Research Department
Japan Marine Science and Technology Center
2-15 Natsushima-cho
Yokosuka, Kanagawa 237-0061
Japan
araki@jamstec.go.jp
William W. Sager
Co-Chief Scientist
Department of Oceanography
Texas A&M University
College Station TX 77843-3146
USA
wsager@ocean.tamu.edu

Carlota Escutia
Staff Scientist
Ocean Drilling Program
Texas A&M University
1000 Discovery Drive
College Station TX 77845-9547
USA
escutia@odpemail.tamu.edu

James E. Arney
Paleontologist (nannofossils)
Department of Geology
Florida State University
108 Carraway Building
Tallahassee FL 32306-4100
USA
arney@gly.fsu.edu

Richard L. Carlson
Physical Properties Specialist
Department of Geology and Geophysics
Texas A&M University
College Station TX 77843-3115
USA
carlson@geo.tamu.edu

*Addresses at time of cruise, except where updated by the leg participants before publication.

mailto:kanazawa@eri.u-tokyo.ac.jp
mailto:wsager@ocean.tamu.edu
mailto:escutia@odpemail.tamu.edu
mailto:araki@jamstec.go.jp
mailto:arney@gly.fsu.edu
mailto:carlson@geo.tamu.edu
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Warna S. Downey
Undergraduate Student Trainee/
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Department of Earth Sciences
Dalhousie University
Halifax NS B3H 3J5
Canada
wdowney@is2.dal.ca

Florence Einaudi
Logging Staff Scientist

Yasutaka Hayasaka
Petrologist
Department of Earth and Planetary Systems 
Science

Graduate School of Science
Hiroshima University
1-3-1 Kagamiyama
Higashi-hiroshima 739-8526
Japan
hayasaka@geol.sci.hiroshima-u.ac.jp
Laboratoire de Mesures en Forage
ODP/Naturalia et Biologia (NEB)
BP 72
13545 Aix-en-Provence Cedex 4
France
einaudi@lmf-aix.gulliver.fr

Sarah L. Haggas
JOIDES Logging Scientist
Department of Geology
University of Leicester
University Road
Leicester LE1 7RH
United Kingdom
slh19@le.ac.uk

Kenji Hirata
Seismologist
Deep Sea Research Department
Japan Marine Science and Technology Center
2-15 Natsushima-cho
Yokosuka, Kanagawa 237
Japan
hiratak@jamstec.go.jp

Benjamin C. Horner-Johnson
Paleomagnetist
Department of Geology and Geophysics
MS-126
Rice University
6100 South Main Street
Houston TX 77005-1892
ben@geophysics.rice.edu

mailto:wdowney@is2.dal.ca
mailto:einaudi@lmf-aix.gulliver.fr
mailto:slh19@le.ac.uk
mailto:hayasaka@geol.sci.hiroshima-u.ac.jp
mailto:hiratak@jamstec.go.jp
mailto:ben@geophysics.rice.edu
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USA
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Department of Earth Sciences

Masashi Mochizuki
Seismologist
Earthquake Research Institute
University of Tokyo
1-1-1 Yayoi, Bunkyo-ku
Tokyo 113-0032
Japan
Present address (16 July 2001):
Institute of Industrial Science
University of Tokyo
4-6-1 Komaba, Meguro-ku
Brock University
500 Glenridge Avenue
St. Catharines ON L2S 3A1
Canada
francine@craton.geol.brocku.ca

Ralph Moberly
Sedimentologist
Department of Geology and Geophysics/SOEST
University of Hawaii at Manoa
2525 Correa Road
Honolulu HI 96822
USA
ralph@soest.hawaii.edu

Tokyo 153-8505
Japan
moma@iis.u-tokyo.ac.jp

Rikke Øhlenschlaeger Pedersen
Paleontologist (foraminifers)
Department of Earth Sciences
Århus Universitet C.F. Møllers Allé
8000 Århus 
Denmark
rik@geo.aau.dk

Ali R.M. Salimullah
Sedimentologist
5959 Bonhomme, No. 234
Houston TX 77036
USA
arms99@msn.com

mailto:moma@iis.u-tokyo.ac.jp
mailto:kmandern@mines.edu
mailto:francine@craton.geol.brocku.ca
mailto:ralph@soest.hawaii.edu
mailto:rik@geo.aau.dk
mailto:arms99@msn.com
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DEDICATION
We, the scientists of Leg 191, wish to express our 
appreciation to our good friend and colleague, Ralph 
Moberly, for his contributions to our cruise and his long 
dedication to ocean drilling and marine geology of the 
Pacific. Ralph is not retiring just yet, but he has 
admitted it will not be far in the future, and Leg 191 
may or may not be his last cruise (sometimes he says it 
will be, but we hope not). Nevertheless, we take this 
opportunity to recognize the accomplishments of a fine 
scientist and true gentleman. When you work with him 
for months at sea, the things you notice about Ralph 
are his extensive knowledge of geology and 

sedimentology (and many other things, for that 
matter), his keen eye for detail, his understated wit, and 
his self-effacing manner. As a scientist on our team, we 
could ask for none better; as a human being, we could 
ask for none more genuine.

Ralph Moberly was a key player in the Deep Sea Drilling 
Program (DSDP) sampling of the western Pacific 
Ocean. He sailed as a scientist on Legs 7, 17, and 61 
and as co-chief scientist on Legs 32 and 89, 

investigating the distribution of sediments and Cretaceous volcanics in the western Pacific. From 1988 
to 1990, he was chairman of the JOIDES Planning Committee and head of the JOIDES office during its 
stay at the University of Hawaii. In the past two decades, Ralph has spent his time serving in a number 
of administrative roles and as chair, as well as guiding the University of Hawaii Geology and 
Geophysics Department from 1990 to 1993 and the Ocean Engineering Department from 1995 to 
1998. Previously, he served as chair of the Geology and Geophysics Department from 1964 to 1965 
and 1975 to 1980 and was associate director of the Hawaii Institute of Geophysics from 1983 to 1990.
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Ralph’s love affair with the sea began with the U.S. Navy in 1950. As a lieutenant junior grade, he 
worked in oceanographic surveying until 1953. After obtaining his Ph.D. at Princeton in 1956, where 
he worked with Harry Hess, Ralph did a brief stint with Standard Oil in California before being hired as 

the third faculty member in the University of Hawaii’s Geology Department in 1959. During the 
1960s, he completed a pioneering study of Hawaiian shorelines and sand reservoirs as well as studies 
of basalt weathering products and their conversion into marine muds. His first DSDP cruise, Leg 7, set 
sail a few months before the end of that decade. During the 1970s, Ralph was one of the first to apply 
the concepts of the then-new global tectonics theory to the western Pacific in an article titled “Origin 
of lithosphere behind island arcs, with reference to the western Pacific.” His interest in active margin 
tectonics continued with his participation in the IDOE Nazca project in the early 1970s. Through the 
decade, he participated in DSDP Legs 17, 32, and 61. Active margins kept Ralph’s interest through the 
1980s, during which he published studies on forearc basins in Peru, Ecuador, and Chile and the 
structure and tectonics of the continental margin of Peru. During 1982, he was co-chief scientist on 
DSDP Leg 89. Since then, his work on Pacific geology has continued as his engagement in 
administrative endeavors have increased.

As he nears the close of a noteworthy career, we wish to recognize Ralph for his unselfish service to the 
ocean drilling community, marine geology, his university, and his students. He is one of those unsung 
heroes who made a difference but did not seek the spotlight. He is also a friend for whom we will 
always harbor fond memories.
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DEDICATION
On the morning of 25 August 2000, everyone on board 
the JOIDES Resolution was jolted by the news that Ross 
Diaz, one of the Filipino roustabouts, was seriously ill, 
having suffered a stroke. It was a time for all on board the 
Resolution to realize how similar we all are, adrift together, 
vulnerable to a turn of bad fortune, and yet how far apart. 
Well known and respected among the crew, few scientists 
could claim to know Ross. Now many of us wish we did, 
for Ross was a dedicated worker, husband, and father. We 
therefore dedicate this volume to Ross Diaz and the other 
unsung heroes like him who make it possible for the Ocean 
Drilling Program to operate at the frontier of science in far-

flung locations on the high seas.

Friends and co-workers speak highly of Ross. They note his 
experience, leadership, loyalty, patience, and hard work. 
Ross began his career working on the Glomar III in 1973. 
Since 1987, he has worked on the JOIDES Resolution. Along 
the way, he trained many of the men who work the drill rig 
floor and earned the nickname “The Godfather” for 
looking after his charges.

Ross was born on 9 December 1945 and grew up in the 
Philippines. He was one of eight children. He married 

Nanie and they have three children and two grandchildren. People who know him say that Ross likes 
the simple pleasures: entertaining friends, playing his guitar, drinking wine with buddies, and 
spending time with his family.

To Ross we say “thanks” for all the hard work over the many years and for loyalty to Sedco, co-
workers, and friends. We also say “farewell and Godspeed” and add a wish for a speedy recovery.
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CD-ROM CONTENTS: CHAPTERS

1. Leg 191 Summary
Shipboard Scientific Party

2. Explanatory Notes
Shipboard Scientific Party

3. Borehole Seismological Observatory
Shipboard Scientific Party

4. Site 1179
Shipboard Scientific Party

5. Hammer-Drill Sites (1180–1182)
G. Leon Holloway and Shipboard Scientific Party
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CD-ROM CONTENTS: CORE DESCRIPTIONS
Visual core descriptions (VCDs), smear-slide and thin-section data tables, and digital micrograph and 
core images are included in this section. VCDs and smear-slide and thin-section data tables are 
combined into one PDF file. ACSII versions of the smear-slide data tables are also available (see “ASCII 
Tables”).

Site 1179

Visual Core Descriptions · Smear Slides · Thin Sections
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CD-ROM CONTENTS: ASCII TABLES
This CD-ROM contains ASCII versions of selected coring summary, biostratigraphy, inorganic 
geochemistry, paleomagnetism, structural geology, physical properties, and borehole instrument 
deployment data tables presented in Chapter 4 and smear-slide data tables presented under “Core 
Descriptions.” A complete listing of the ASCII data tables can be found on the next two pages. 

You can access these data directly from the PDF files. Depending on your computer platform, the 
following information applies.

PC COMPUTERS
By default, clicking on a filename with a .TXT extension will launch the Notepad application. You can 
configure your computer’s operating system so that files on this CD with .TXT extensions 

automatically open in other software, such as Microsoft Excel. Follow these steps from the pull-down 
menu: Windows 95 and NT operating systems: View > Options > File Types; and Windows 98 systems: 
View > Folder Options > File Types.

MAC COMPUTERS
All table files with .TXT extensions will automatically open into Excel. If you do not have Excel installed 
on your computer, you may view these files through other spreadsheet or text-editor programs. Open 
the application of your choice, select File > Open, and open the ASCII file.

UNIX COMPUTERS
You can open files with .TXT extensions in any text editor or spreadsheet program, but not directly 
from PDF files.

Chapter 4 Smear-slide data tables
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Chapter 4, Site 1179
Table T1. Coring summary, Site 1179. 
Table T2. Carbon and elemental analyses of Site 1179 sediments.
Table T3. Distribution and relative abundance of radiolarians, Site 1179. 
Table T4. Core samples collected for microbiological experiments and results of chemical analyses. 
Table T5. Magnetic susceptibility tie point depths correlating cores from Holes 1179A, 1179B, and 
1179C. 

Table T7. Subdivision of the basalt pile, Hole 1179D.
Table T8. Phenocryst distribution in basalts, Hole 1179D.

Table T9. Glass/palagonite contents of basalts, Hole 1179D.
Table T10. Chemical analyses of basalts, Hole 1179D.
Table T11. CIPW norm composition of basalts, Hole 1179D.
Table T12. PWS3 split-core P-wave velocities.
Table T13. Index properties of discrete samples, Holes 1179A, 1179B, and 1179C.
Table T14. Thermal conductivity values, Holes 1179A, 1179B, and 1179C.
Table T15. P-wave velocities and densities in basalts. 
Table T16. Average physical properties by lithostratigraphic unit.
Table T17. Vane shear data, Holes 1179A, 1179B, and 1179C.
Table T18. Correlation of reflection traveltime with the lithostratigraphic column using measured 
P-wave velocities, Site 1179. 

Table T19. Correlations of reflection traveltime with the lithostratigraphic column, Site 1179.
Table T20. Instrument package deployment, Site 1179.

Smear-Slide Data Tables
Smear-slide table, Holes 1179A and 1179B.
Smear-slide table, Holes 1179C and 1179D.
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CD-ROM CONTENTS: SUPPLEMENTARY MATERIALS
This CD-ROM contains supplementary materials consisting of JPG and HTML photographs that 
present a pictoral record of the preparation and installation of the borehole seismometer instruments. 
For a thumbnail view of the photographs and links to the captions, see SUPP_MAT/BOREHOLE/
INDEX.HTM. If this link does not open INDEX.HTM, users may open the file directly in a Web browser.
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CD-ROM CONTENTS: DRILLING LOCATIONS MAPS
A site map showing the drilling locations for this leg and maps showing the drilling locations of all 
Ocean Drilling Program (ODP) and Deep Sea Drilling Project (DSDP) drilling sites are available in PDF 
format.

ODP Leg 191 Site Map

ODP Map (Legs 100–191)

DSDP Map (Legs 1–96)
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RELATED LEG DATA
DOWNHOLE LOGGING AND CORE DATA

A second CD-ROM is included with this volume. The “Log and Core Data” CD contains Leg 191 
depth-shifted and processed downhole logging data and shipboard core logging data (gamma-ray 
attenuation bulk density, natural gamma radiation, magnetic susceptibility, P-wave velocity, and 
moisture and density). The downhole logging data are provided by the Borehole Research Group at 
the Lamont-Doherty Earth Observatory, Wireline Logging Operator for ODP.

The majority of the logging data included on the CD are available on the World Wide Web at 
www.ldeo.columbia.edu/BRG/ODP. If you cannot access this site or want to order the CD, please 
contact: ODP Logging Services Operator, Lamont-Doherty Earth Observatory, Route 9W, Palisades NY 
10964, USA; Tel: (845) 365-8341; Fax: (845) 365-3182; E-mail: borehole@ldeo.columbia.edu.

The majority of the core data on the CD are available on the Web at www-odp.tamu.edu/database. 
If you cannot access the ODP database or need additional data, please contact: ODP Data Librarian, 
Ocean Drilling Program, Texas A&M University, 1000 Discovery Drive, College Station TX 77845-
9547, USA; Tel: (979) 845-8495; Fax: (979) 458-1617; E-mail: database@odpemail.tamu.edu.

http://www.ldeo.columbia.edu/BRG/ODP
mailto:borehole@ldeo.columbia.edu
http://www-odp.tamu.edu/database
mailto:database@odpemail.tamu.edu
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COMPILED ELECTRONIC INDEX
The Compiled Electronic Index of the Proceedings of the Ocean Drilling Program included on the Initial 
Reports CD-ROM contains individual indexes of Volumes 101–171B, 173, and 174B. The indexes are 
contained in the directory titled ODPINDEX and are named ###NDX.PDF (### = the leg number). 
These indexes can be searched individually or collectively.
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CD-ROM DIRECTORY STRUCTURE 

ACROREAD
(Acrobat Reader 4.0.5 installation 
software and instructions for 
different platforms)

191IR.PDF
(Preliminary pages and table of contents)

README.TXT

IR191_01.PDF (Leg 191 Summary)VOLUME
(Leg 191 Initial Results volume)

README.PDF
(Information about the volume CD-ROM)

README.TXT
(Information about the volume CD-ROM in ASCII format)

MAPS
(Drilling locations maps)

ODPMAP.PDF
(ODP map, Legs 100 through 191)

CHAPTERS
(Volume chapters)

191_MAP.PDF
(Leg 191 site map)

IR191_02.PDF (Explanatory Notes)

IR191_03.PDF (Borehole Seismological Observatory)

IR191_04.PDF (Site 1179)

IR191_05.PDF (Hammer-Drill Sites [1180–1182])

DSDPMAP.PDF
(DSDP map, Legs 1 through 96)

TABLES
(ASCII-format tables of selected 
coring summary, biostratigraphy, 
inorganic geochemistry, 
paleomagnetism, structural geology, 
physical properties, borehole instrument deployment,
and smear-slide data)  

IR191_04 (Site 1179 files)

S_SLIDES (Smear slides from Site 1179)

README.TXT

(Continued on next page)

INDEX.PDX
(Acrobat file used to enable Acrobat Search of the
191 Initial Reports) 

COR_1179.PDF (Site 1179) CORES
(Visual core descriptions, smear-slide
and thin-section data tables, and 
digital photomicrograph and core 
images)

IMAGES (PDF files of core images)

PHOTOMIC (PDF files of photomicrographs)

MAC

WINDOWS

UNIX

BOREHOLE
(Digital photographs of preparation 
and installation of the borehole 
instrument assembly)

INDEX.HTM (Main page)

PHOTO001.HTM through PHOTO128.HTM
(Photo pages)

INDEX001.JPG through INDEX128.JPG 
(Photo thumbnails)

PHOTO001.JPG through PHOTO128.JPG 
(Full-sized photos)

CAPTIONS.HTM (Explanations of photos)

README.TXT

SUPP_MAT
(Supplementary Material)

ODPINDEX
(Compiled Electronic Index of the
Proceedings of the Ocean Drilling
Program)

101NDX.PDF through 171BNDX.PDF, 
173NDX.PDF, and 174BNDX.PDF
(Index files)

NDX.PDX
(Acrobat file used to enable Acrobat Search of the
Compiled Electronic Index)
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